
The science behind the report:

Greatly accelerate project 
management tasks by leveraging 
AI workflows on modern PCs 
powered by AMD Ryzen processors

This document describes what we tested, how we tested, and what we found. To learn how these facts translate 
into real-world benefits, read the report Greatly accelerate project management tasks by leveraging AI workflows 
on modern PCs powered by AMD Ryzen processors.

We concluded our hands-on testing on February 21, 2026. During testing, we determined the appropriate 
hardware and software configurations and applied updates as they became available. The results in this report 
reflect configurations that we finalized on February 7, 2026 or earlier. Unavoidably, these configurations may not 
represent the latest versions available when this report appears.

Our results
To learn more about how we have calculated the wins in this report, go to https://facts.pt/calculating-and-highlighting-wins.  
Unless we state otherwise, we have followed the rules and principles we outline in that document.

Using AI vs manual approach on an HP EliteBook X G2a

Table 1: Time to complete tasks on the HP EliteBook X G2a with and without AI. Source: PT.

Task
Time without AI 
hh:mm:ss

Time with AI 
hh:mm:ss

Time saved with AI 
hh:mm:ss

Time saved with AI 
Percentage

Generating and scheduling tasks 
from emails 0:07:12 0:00:49 0:06:23 88.6%

Summarizing a meeting transcript 0:38:27 0:01:40 0:36:47 95.6%

Reviewing Jira tickets 0:20:09 0:02:49 0:17:20 86.0%

Creating a project plan 0:30:14 0:11:42 0:18:32 61.3%

Creating a Gantt chart in Excel 0:08:12 0:02:18 0:05:54 71.9%

Updating a presentation 0:03:11 0:01:00 0:02:11 68.5%

Managing client communication and 
scheduling meetings 1:47:25 0:04:36 1:42:49 95.7%
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Using AI on an HP EliteBook X G2a vs using a manual approach on an HP EliteBook 865 G9

Table 2: Results of our testing. Less time is better.

HP EliteBook 
X G2a

HP EliteBook 
865 G9

Time saved on the 
HP EliteBook X G2a 
with AI 
hh:mm:ss

Time saved on the 
HP EliteBook X G2a 
with AI 
Percentage

Time to complete task (mm:ss) with AI without AI

Generating and scheduling tasks 
from emails

0:00:49 0:07:20 0:06:31 88.8%

Summarizing a meeting transcript 0:01:40 0:38:34 0:36:54 95.6%

Reviewing Jira tickets 0:02:49 0:20:36 0:17:47 86.3%

Creating a project plan 0:11:42 0:30:14 0:18:32 61.3%

Creating a Gantt chart in Excel 0:02:18 0:08:12 0:05:54 71.9%

Updating a presentation 0:01:00 0:03:18 0:02:18 69.6%

Managing client communication and 
scheduling meetings

0:04:36 0:20:04 0:15:28 77.0%

Total 0:24:54 2:08:18 1:43:24 80.5%

Table 3: Results of our testing extrapolated over a workweek. Less time is better.

HP EliteBook 
X G2a

HP EliteBook 
865 G9

Time saved on the 
HP EliteBook X G2a 
with AI 
hh:mm:ss

Time saved on the 
HP EliteBook X G2a 
with AI 
Percentage

Time to complete task (mm:ss)
Estimated 
iterations 
per week

with AI without AI

Generating and scheduling 
tasks from emails

5 0:04:05 0:36:40 0:32:35 88.8%

Summarizing a meeting 
transcript

5 0:08:20 3:12:50 3:04:30 95.6%

Reviewing Jira tickets 10 0:28:10 3:26:00 2:57:50 86.3%

Creating a project plan 1 0:11:42 0:30:14 0:18:32 61.3%

Creating a Gantt chart in Excel 1 0:02:18 0:08:12 0:05:54 71.9%

Updating a presentation 1 0:01:00 0:03:18 0:02:18 69.6%

Managing client communication 
and scheduling meetings

50 3:50:00 16:43:20 12:53:20 77.0%

Total (hh:mm:ss) 4:45:35 24:40:34 19:54:59 80.7%
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Testing productivity while simultaneously running a large language model

Table 4: Procyon Office Productivity benchmark scores while simultaneously running an LLM on a current AMD Ryzen AI processor-powered 
PC (equipped with a GPU and an NPU) and a previous-gen PC (equipped with a GPU). Higher is better. Source: PT.

Procyon Office 
Productivity

HP EliteBook X G2a    
model running on NPU

HP EliteBook 865 16 inch 
G9 Notebook PC  

model running on GPU
Percentage improvement

Overall rating - Median 7,137 3,621 97.1%

Word score  7,738  4,304 79.7%

Excel score  6,834  3,331 105.1%

PowerPoint score  8,388  4,177 100.8%

Outlook score  4,870  2,280 113.5%

System configuration information
Table 5: Detailed information on the systems we tested.

System configuration information HP EliteBook X G2a HP EliteBook 865 16 inch G9 Notebook PC

Processor

Vendor AMD AMD

Model number Ryzen AI 7 PRO 450 CPU w/ Radeon 860M AMD Ryzen 5 PRO 6650U with Radeon Graphics

Core frequency (MHz) 2,000 2,900

Number of cores 8 6

Cache (MB) 16 16

Memory

Amount (GB) 32 32

Type LPDDR5 DDR5

Speed (MHz) 8,533 4,800

Integrated graphics

Vendor AMD AMD

Model number AMD Radeon™ 860M Graphics AMD Radeon Graphics 

Storage

Amount (GB) 500 512

Type SSD SSD
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System configuration information HP EliteBook X G2a HP EliteBook 865 16 inch G9 Notebook PC

Connectivity/expansion

Wired internet Via USB-C Adapter NA

Wireless internet MediaTek Wi-Fi 7 MT7925 Realtek RTL8852BE 802.11ax (2x2) Wi-Fi

Bluetooth Bluetooth® 5.4 wireless card Bluetooth M.2 2230 PCIe

USB 1 x USB  Type-C 10Gbps signaling rate (USB 
Power Delivery/DisplayPort 2.1)

1 x USB Type-A 10Gbps signaling rate 
(powered)

USB Worldwide WLAN

2 x USB4 Type‑C 40Gbps signaling rate (USB 
Power Delivery/DisplayPort 1.4)

2 x USB 3.2 Gen 1 Type‑A 5Gbps signaling rate 
(1 x charging)

1 x headphone/microphone combo jack

Thunderbolt 2 x Thunderbolt 4 with USB Type-C 40Gbps 
signaling rate (USB Power Deliver/DisplayPort 
2.1)

NA

Video 1 x HDMI 2.1 1x HDMI 2.0

Battery

Type Undisclosed HP Long Life 3-cell, 51 Wh Li-ion polymer

Size 3-cell 3-cell

Rated capacity (Wh) 56 51

Display

Size (in.) 14 15.9

Type WUXGA LED‑backlit

Resolution 1,920 x 1,200 1,920 × 1,080

Touchscreen No Yes

Operating system

Vendor Microsoft Microsoft

Name Microsoft Windows 11 Pro Windows 11 Pro

Build number or version 10.0.26200 (Build 26200) 10.0.22621 (Build 22621)

BIOS

BIOS name and version HP Y88 Ver. 85.02.01 HP U82 Ver. 01.14.00

Dimensions

Height (in.) 0.52 0.76

Width (in.) 12.29 14.12

Depth (in.) 8.45 9.88

Weight (lb.) 2.52 3.9
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How we tested

Initial system setup for all scenarios

AMDTest folder
1.	 Download and extract the folder to the C drive.

Installing AMD Adrenaline 
1.	 Go to https://www.amd.com/en/support/download/drivers.html to get the latest AMD Adrenaline application.
2.	 Click Download Windows Drivers. 
3.	 Open the executable, and proceed with installation.
4.	 Click Accept & Express Install to install the necessary drivers.
5.	 Wait for the installation to finish.
6.	 Restart the system when prompted.

Generating and scheduling tasks from emails

Installing and setting up Lemonade 
1.	 Download Lemonade Server from https://lemonade-server.ai/.
2.	 Launch the installation and use the default settings throughout the installation.
3.	 At the end of the installation, select the option to Run Lemonade Server now. 
4.	 Wait 10 to 20 seconds for the Lemonade notification to pop up in the lower-right corner of the screen. Lemonade server is now running 

in the background. 
5.	 If Lemonade isn’t running, manually launch it through the Windows search bar. 
6.	 In the taskbar, right-click the Lemonade icon, and select Open app. 
7.	 In the search field in the left sidebar, type Llama-3.2-3B-Instruct-Hybrid
8.	 Select the download button next to the model.
9.	 When the download completes, load the newly installed model Llama-3.2-3B-Instruct-Hybrid by clicking on the play icon next to 

the model name.

Installing and setting up Noodle 
Note: For this test, we used an alpha version of the Noodle app that AMD provided to us.

1.	 Install the noodle-ui2112025759p executable.
2.	 Launch the Noodle executable.
3.	 Enter the purchased token in the Enrollment key field and select Enroll with Token.
4.	 Finish the installation with default settings.
5.	 In the app, select Settings.
6.	 In the Email Accounts section, click Connect on the Gmail/Google Workspace account.
7.	 Enter the username and password for the account under test, and click Save.
8.	 In the AI Configuration section of settings, under AI Mode, select AMD Lemonade from the drop-down menu.
9.	 In the AI Configuration section, under Model Name, enter LFM2-8B-A1B-GGUF
10.	 Select Save AI Configuration.

AI-enhanced workflow
1.	 Open Noodle.
2.	 Simultaneously start the stop watch and open the Emails page in the application. 
3.	 Find the Pippin Fiesta email, and select it. 
4.	 Click Ask to ask questions and create tasks related to the email. 
5.	 This opens a new chat with the email as an attachment for context.
6.	 Provide the following prompt to break the tasks mentioned in the email into subtasks: 

Break the tasks mentioned in the email into subtasks. 

7.	 Click Send.
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8.	 Copy the AI generated answer by clicking Copy.
9.	 Open Word.
10.	 Simultaneously paste the AI-generated answer into Word, and stop the stopwatch.
11.	 Record the results and repeat steps 1 through 10 two more times. 

Traditional workflow
1.	 Open Outlook.
2.	 Simultaneously start the stopwatch and select the Focused tab.
3.	 Find the Pippin Fiesta email, and select it. 
4.	 Open Word. 
5.	 Read the email, and create a list of subtasks in Word.
6.	 When the list of subtasks is complete, stop the stopwatch.
7.	 Record the results and repeat steps 1 through 6 two more times.

Summarizing a meeting transcript 

Installing and setting up Lemonade 
1.	 Download and install Lemonade Server from https://lemonade-server.ai/.
2.	 Place the LFM2-2.6B-Transcript-1-GGUF model file in a folder titled Liquid in the Downloads folder.
3.	 In Windows Search, type CMD 
4.	 With the Command Prompt highlighted, select Run as administrator.
5.	 In the Command Prompt window, type

lemonade-server serve –extra-models-dir C:/Users/Username/Downloads/Liquid and press Enter.

6.	 In the Taskbar, right-click the Lemonade icon, select Load Model and choose extra.LFM2-26B-Transcript-1-GGUF.gguf.

Setting up Generate AI 
Note: Before proceeding, make sure Lemonade is running. 

1.	 Launch the generateinstaller1216.exe file.
2.	 Click through the installation using the default selections.
3.	 After installation, launch Generate. 
4.	 After the application loads the Register page, enter your username, password, and license key.
5.	 Close Generate.

AI-enhanced workflow
1.	 Launch the Lemonade-server application.
2.	 In the Taskbar, right-click the Lemonade icon, select Load Model, and choose extra.LFM2-26B-Transcript-1-GGUF.gguf.
3.	 Select the Generate AIPC menu in the lower-right corner, and select Settings.
4.	 Select the Card Manager tab.
5.	 Select the New Card + button on the lower right side. It will open new screen to edit a card.
6.	 In Category, select General.
7.	 Select the icon field, and choose an icon from the window that appears.
8.	 In the tile field, enter Meeting Minutes Creator
9.	 In the description field, enter 

The card will ingest your meeting transcript or notes and then be able to generate full meeting 
minutes report.

10.	 In Step 1, choose Pick Integration for select a tool.
11.	 Select Add Another Tool, and select Pick File.
12.	 Select Step 1 for Select a step to pick integration.
13.	 Select Add Another Tool, select Get User Input. 
14.	 In the Message field, type 

Get input if not already written 
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15.	 In the Question field, type 

What points did you want to focus on?

16.	 Select Add Another Tool, select Search Vector DB.
17.	 In the Message field, type 

Select integration if not already written

18.	 In the Query field, type 

Pull all relevant content from the meeting notes/transcript that include action items, next steps, 
meeting participants, have a focus on the areas covered here $3.output.

19.	 Select Step 1 for Select a step to pick integration.
20.	 Select Step 2 for Select a step to pick source.
21.	 For No of Chunks, type 5
22.	 Select Add Another Tool, select Generate LLM Response.
23.	 In the Message field, type 

Generating Response if not already written

24.	 In the Instruction field, type 

You are a meeting note taker, using the meeting transcript/notes create a full meeting minutes 
report that highlights the main points of the meeting, key takeaways, action items, along with any 
other relevant content that would need to be considered.

When outputting the report, create it with this guideline covering these sections in order: 
Participants of the Meeting 
Executive Summary 
Key Points from the Meeting 
Action Items

Don’t have to necessarily include all the points mentioned earlier if there is not much data.

Provide result in text format that does not contain tables or other heavy formatting, just basic 
formatting like using strictly dashes and spaces only. And include as little formatting as possible 
please. And please structure spaces accurately and consistently.

Please provide output that when copied for usage, will provide all the formatting of the 
generated results.

Make the final output as short and concise as possible.

25.	 In the Relevant content field, type $4.output
26.	 Click Save.
27.	 Simultaneously start the stopwatch and click the Select Model drop-down menu in the upper-right corner.
28.	 Select the user.LFM2-2.6B-Transcript-1-GGUF model to load it.
29.	 Go to Home, search for Meeting Minutes Creator, and open it.
30.	 Click Local Files option.
31.	 Click Upload file, navigate to your meeting notes Word file, and upload it.
32.	 Select the uploaded meeting note file, and click Continue.
33.	 Provide the main point you want to focus on from the meeting and continue.
34.	 Wait for it to generate the response.
35.	 Open Word.
36.	 Copy the generated meeting notes summary, and paste it into Word.
37.	 Simultaneously stop the stopwatch and save the Word document.
38.	 Record the time.

39.	 Repeat steps 1 through 38 two more times.
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Traditional workflow
1.	 Simultaneously start the timer and open the meeting transcript with Word.
2.	 Read through the entire document carefully, identifying: 

• Participants of the meeting

• Executive summary

• Key points from the meeting

• Action items

3.	 Highlight or note down the important sections manually. 
4.	 Open a new blank Word document to begin drafting the meeting minutes. 
5.	 Start writing the report using the following structure: 

• Participants of the meeting (List all attendees based on the transcript)

• Executive summary (Summarize the overall purpose and outcome of the meeting)

• Key points from the meeting (List major topics discussed and insights shared)

• Action items (Mention tasks assigned, responsible persons, and deadlines if available)

6.	 Use only basic formatting: dashes for bullet points and consistent spacing.
7.	 Review the document for clarity, conciseness, and completeness. 
8.	 Simultaneously stop the stopwatch and save the Word document.
9.	 Record the time.
10.	 Repeat steps 1 through 9 two more times. 

Reviewing Jira tickets

Installing and setting up Lemonade 
1.	 Download Lemonade Server from https://lemonade-server.ai/.
2.	 Launch the installation and use the default settings throughout installation.
3.	 Finish the installation with the launch option selected.
4.	 Wait 10 to 20 seconds for the Lemonade notification to pop up in the lower-right corner of the screen. Lemonade server is now running 

in the background. 
5.	 Right-click the Lemonade icon in the taskbar, and select Open app.	
6.	 In the search field in the left sidebar, type gpt-oss-20b-mxfp4-GGUF
7.	 Select the download button next to the model.
8.	 When the download completes, load the newly installed model gpt-oss-20b-mxfp4-GGUF by clicking on the play icon next to 

the model name.
9.	 Open the taskbar popup and right-Click lemonade. Select Context Size from the menu and choose 16k.

Installing Generate AI PC 
1.	 Open the generateinstaller1216.exe file.
2.	 Click through the installation using the default selections.
3.	 After installation, launch Generate. 
4.	 Enter your username, password and license key when the application loads the Register page. 
5.	 From the Select Model drop-down menu in the upper-right corner, select gpt-oss-20b-mxfp4-GGUF.

6.	 Close Generate.

Setting up JIRA 
1.	 Go to https://www.atlassian.com/software/jira and sign up/login using your account.
2.	 Select Continue without two factor authentication. 
3.	 Select Go to Jira or Jira Service Management.
4.	 Note down the URL before /jira/software/projects. For example: https://radteam-lab.atlassian.net.
5.	 Click the profile picture on the upper-right corner of the screen, and select Account settings option.
6.	 In the upper section of the screen, click Security.
7.	 Select Create and manage API tokens, and verify your identity.
8.	 Select Create API token, and provide name.
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9.	 Click Create.
10.	 Copy the generated API token, and save it securely.
11.	  Click Done, and close the tab.

Adding tickets/work items
1.	 Go back to the Spaces - Jira tab.
2.	 Click the MexiCat space.
3.	 Go to List view by clicking on the List button under the Mexicat title.
4.	 Hover over the Type of the KAN-11 ticket and Click the + button to create a new work item.
5.	 Enter the following text in the text box and press create or press the enter key to create the work item. Mobile App Integration 

for MexiPetFeeder.
6.	 Assign the work item to yourself by clicking on the Unassigned button and selecting the first option from the drop-down menu.
7.	 Open the work item by clicking its key.
8.	 Add the following description:

Develop and test a companion mobile app feature that allows users to: 
	 - Schedule feeding times remotely. 
	 - Receive push notifications for low food/water levels. 
	 - Track pet feeding history and health metrics. 
	 - Provide firmware update prompts for the feeder.

9.	 Click Save.
10.	 Close out of the ticket by clicking the x in the upper-right corner.
11.	 Create another work item and enter the following title: Feeder Portion Calibration Bug
12.	 Click the Type drop-down menu, and select bug.
13.	 Open the ticket and enter the following description:

During internal testing, some feeders dispense inconsistent portion sizes compared to the programmed 
amount. This issue could lead to overfeeding or underfeeding pets. 
- Investigate root cause in the dispensing mechanism and firmware logic. 
- Validate calibration across multiple units. 
- Implement fix and regression test to ensure accuracy.

14.	 Save the ticket, and close.

15.	 Create eight more tickets with similar descriptions.

AI-enhanced workflow
1.	 Launch Lemonade-server.
2.	 Load the gpt-oss-20b-mxfp4-GGUF model.
3.	 Open the Generate AI PC application if it is not already running.
4.	 Click MCP Playground, and select the setting icon besides the JIRA option.
5.	 In the JIRA MCP setting popup, enter the following details: 

JIRA-AUTH-TYPE: basic 
JIRA-URL: (Type the URL saved in setup). 
JIRA-USERNAME: (Type the email address you used to signup/login into JIRA). 
JIRA-API-TOKEN: (Copy and paste the API token that you previously saved).

6.	 Click Save.
7.	 Turn on the toggle besides the JIRA option. Jira Chat will open.
8.	 Simultaneously start the stopwatch and enter this prompt:

Summarize all Jira issues updated today across all projects and email me the team update. 
and click Send.

9.	 When the output completes, copy the text and paste it into a Word document.
10.	 Simultaneously stop the stopwatch and save the Word document.
11.	 Record the time. 

12.	 Repeat steps 1 through 11 two more times.
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Traditional workflow
1.	 Simultaneously start the stopwatch and log into Jira.
2.	 Open each relevant project.
3.	 Manually apply a filter:

updated >= startOfDay() AND updated <= endOfDay()

4.	 Review each issue’s activity log for changes.
5.	 Copy relevant comments, transitions, and new issues and paste them into a Word document.
6.	 Manually summarize changes in a Word document.
7.	 Write a daily summary draft with the content in the Word document.
8.	 When the summary is complete, simultaneously stop the stopwatch and save the Word document.
9.	 Record the time.

10.	 Repeat steps 1 through 9 two more times.

Creating a project plan 

Installing LM Studio 
1.	 Open browser and go to https://lmstudio.ai/download. 
2.	 Click Download for Windows. Wait for the download to finish.
3.	 Launch the installation, using the default settings throughout the installation.
4.	 Finish the installation with the Run LM Studio option selected. 
5.	 Click Ok to close popups. 
6.	 Click the search icon in the upper-right corner of the app window. 
7.	 Search for Gemma 3 12B model in the search bar.
8.	 Select the matching option, and click the download button on the lower-right corner of the popup. Wait for the download to finish. 
9.	 Click the Load Model popup, which appears after the model has been downloaded. 
10.	 Wait for the model to finish loading. 

Installing and setting up Excel 

Setting up OneDrive (Required)

1.	 Search for OneDrive in the search bar, and open OneDrive. 
2.	 Sign in with your Microsoft 365 account.
3.	 Follow the prompts and finish the setup process.

Installing Excel 

1.	 Search for Excel in the search bar, and open Excel.
2.	 Click accept on the License Agreement page if prompted.
3.	 Ensure the Microsoft Account associated with the application has a valid license. If not follow these steps to login to a valid account:

a.	 Click the Microsoft Account button beside the Minimize Button.
b.	 Click the Sign in with a different account button. 
c.	 Enter your email. Click next.
d.	 Enter your password.
e.	 Select No, this app only option.
f.	 On the Update window popup, click close.

4.	 Close Excel.
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AI-enhanced workflow
1.	 Simultaneously start the stopwatch and launch LM Studio.
2.	 Load the Gemma 3 12B model.
3.	 Type the following prompt: 

Make a project plan in Excel to run a mini project to solve a critical problem in final UI design. 
Include all roles needed, 4-week duration. 

4.	 Press Enter. Wait for the LLM to complete its response.
5.	 Review the generated Project Plan for accuracy, conciseness, and key insights.
6.	 Type the following prompt: 

Create a CSV file of the table that I can import into Excel and click enter. 

7.	 Wait for the prompt to finish generating.
8.	 Click Copy to copy the generated csv. 
9.	 Open file explorer, and navigate to the extracted AMDTest folder in your C Drive. 
10.	 Click the View drop-down menu located in the top bar. 
11.	 Click the Show > button to open the drop-down menu, and make sure the File name extensions is checked. 
12.	 Close out of it by clicking anywhere outside the menu.
13.	 Create a new file by right-clicking anywhere within the empty folder space, hovering or clicking New, and selecting Text Document. 
14.	 Name the file as updated project plan.txt and click enter. 
15.	 Right-click the file, and click Open to open with Notepad. 
16.	 Paste the copied CSV file produced by the LLM from LM Studio.
17.	 Click File, and click Save from the drop-down options. 
18.	 Close out of Notepad by clicking on the X icon in the upper-right corner. 
19.	 Right-click the updated project plan.txt file, and click Rename. 
20.	 Change the file extension from .txt to .csv, and click Enter.
21.	 In the rename warning popup, click Yes. 
22.	 Open the file with Excel by right-clicking the file and clicking Excel. 
23.	 Ensure the formatting is correct.
24.	 Simultaneously stop the stopwatch and save the Excel file.
25.	 Record the time.
26.	 Repeat steps 1 through 25 two more times.

Traditional workflow
1.	 Simultaneously start the timer and open Excel.
2.	 Identify Key Tasks/Activities: Brainstorm all the things that need to happen to complete your project. 
3.	 Break items into appropriate phases (e.g., Planning, Design, Development, Testing, Deployment).
4.	 Estimate Task Durations: How long will each task take? Consider dependencies and potential roadblocks.
5.	 Assign Resources: Who’s responsible for each task? This helps with accountability and workload management.
6.	 Define Milestones: These are significant checkpoints in your project – key deliverables or completion of phases.
7.	 Review the updated Project Plan for accuracy, conciseness, and key insights.
8.	 Update the Excel project plan to include these steps, mapping to the appropriate roles in sheet.
9.	 When the project plan is complete, simultaneously stop the stopwatch and save the Excel file.
10.	 Record the time.
11.	 Repeat steps 1 through 10 two more times.
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Creating a Gantt Chart in Excel 

AI-enhanced workflow
1.	 Launch Excel with Copilot.
2.	 Simultaneously start the stopwatch and open the project plan Project Plan MexiCat MexiPet.xlsx.
3.	 Select the toggle button beside AutoSave, located near the upper-left corner, to enable auto save.
4.	 In the popup, select the OneDrive account created in setup.
5.	 On the Automatically saving popup that appears, select Got it.
6.	 In the ribbon, click Copilot .
7.	 Enter the following prompt:

Give me the steps to make a Gantt chart of tasks from this sheet

8.	 Review the generated summary for accuracy, conciseness, and key insights.
9.	 Expected result: 

To create a Gantt chart using the data in the table-like range A1:N77 on the MexiCat_GuacCat Tableau 
2 sheet, follow these steps: 
Steps: 
Prepare the Data: 
Ensure the columns Task, Start Date, and End Date are properly formatted. The Start Date and End 
Date columns already use the m/d/yyyy format. 
Insert a Stacked Bar Chart: 
Select the Task, Start Date, and Duration columns (Duration can be calculated as =DATEDIF(Start 
Date, End Date, d) if not already present). 
Go to the Insert tab and choose a Stacked Bar Chart. 
Format the Chart: 
Set the Task column as the vertical axis (categories). 
Use the Start Date as the first series and Duration as the second series. 
Format the Start Date series to be invisible (no fill) to create the Gantt chart effect. 
Adjust the Chart: 
Reverse the order of tasks on the vertical axis. 
Format the horizontal axis to display dates. 
Let me know if you need detailed instructions for any step!

10.	 The summary should accurately capture the main points of the document in a well-organized format (e.g., headings, bullet points).
11.	 Follow the steps to create a Gantt chart.
12.	 Stop the stopwatch when the Gantt chart is created.
13.	 Record the time.
14.	 Repeat steps 1 through 13 two more times.

Traditional workflow 
1.	 Launch Excel (no Copilot).
2.	 Prepare the stopwatch.
3.	 Simultaneously start the stopwatch and open the project plan Project Plan MexiCat MexiPet.xlsx.
4.	 In the menu bar, click Help.
5.	 In the ribbon, click Help.
6.	 Enter the following prompt:

Give me the steps to make a Gantt chart of tasks from this sheet

7.	 Review the static help text for accuracy, conciseness, and key insights.
8.	 Expected result: 

A Gantt chart illustrates a project schedule. It primarily has four columns: task, start date, end 
date, and duration. To find Gantt chart templates, follow these steps: 
On the File tab, select New.  
Select a Gantt chart from the gallery, or type Gantt charts into the Search for online 
templates field. 
Choose a chart and follow the prompts to download. Customize the Gantt chart with your 
own data and save.
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9.	 On the left side of the window, click New.
10.	 In the search bar in the main window, type Gantt Chart
11.	 Select the Simple Gantt chart template.
12.	 Click Create. 
13.	 While referencing the support resources, replace the data in the Simple Gantt chart with the correct fields from the Project Plan 

MexiCat MexiPet.xlsx.
14.	 Ensure the data is structured as explained in support resource.
15.	 Stop the stopwatch when the Gantt chart is completed.
16.	 Record the time.

17.	 Repeat steps 1 through 16 two more times with different users.

Updating a presentation

Setting up PowerPoint
1.	 Launch PowerPoint. 
2.	 Click to accept the License Agreement if prompted.
3.	 Sign in with a Microsoft Account that has a valid license.
4.	 Close PowerPoint.
5.	 Relaunch PowerPoint. 
6.	 In the navigation bar on the left side of the app window, click Open. 
7.	 Click Browse.
8.	 Navigate to the mexicat_presentation.pptx file from the mexicat folder in the zip file, and open the file. 
9.	 Accept the License Agreement if prompted.

Setting up Word
1.	 Launch Word.
2.	 Click to accept the License Agreement if prompted.
3.	 Sign in with a Microsoft Account that has a valid license.
4.	 Close Word.
5.	 Relaunch Word. 
6.	 In the navigation bar on the left side of the app window, click Open. 
7.	 Click Browse. 
8.	 Find Press Release_MexiCat Launch.docx file from mexicat folder inside the extracted folder, and open the file.

AI-enhanced workflow
1.	 Open mexicat_presentation.pptx and mexicat_press_release.docx.
2.	 In Power Point, simultaneously start the stopwatch and Insert a new blank slide by clicking on the New Slide drop-down button within 

the Slides section in the tab above, then clicking on the BLANK slide from the drop-down menu.
3.	 Switch to the slide with the title Background (slide 7 after new blank slide), and use the Click to Do (Windows key + Q) feature to select 

the image of a black cat smiling.
4.	 In the Click to Do drop-down menu, select Blur Background with Photos. 
5.	 When the image file of the selected photo pops up on the right pane, select Replace. 
6.	 Click Save options.
7.	 In the drop-down menu, click Copy to Clipboard, and minimize the popup (don’t close it).
8.	 Go to the new blank slide created earlier, and paste the newly edited white background image to the right side of the slide.
9.	 Minimize the PowerPoint application (don’t close it).
10.	 Go to the mexicat_press_release.docx window.
11.	 Make the entire document visible by switching to the View tab and clicking on Multiple Pages within the zoom section. 
12.	 Open Click to Do with (Windows key + Q).
13.	 Select the Rectangular selection tool at the top. 
14.	 Highlight the entire document using the rectangular selection tool. 
15.	 In the drop-down menu that appears, select Create a bulleted list. 
16.	 After the bulleted list is generated, in the lower-right corner, click Copy. 
17.	 Click the x button at the top to close out of Click to Do. 
18.	 Paste the bulleted list into the blank slide within the mexicat_presentation.pptx file.
19.	 Format the bullet points correctly. 
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20.	 Select Save as, and enter the following title: updated_mexicat_presentation.pptx
21.	 Simultaneously stop the stopwatch and select Save.
22.	 Record the time.
23.	 Repeat steps 1 through 22 two more times.

Traditional workflow
1.	 Open mexicat_presentation.pptx and mexicat_press_release.docx.
2.	 In PowerPoint, simultaneously start the stopwatch and insert a new blank slide by clicking on the New Slide drop-down button within 

the Slides section in the tab above, then clicking on the BLANK slide from the drop-down menu.
3.	 Navigate to slide with the MexiCat Image. Right-click the image (smiling black cat), and select Copy.
4.	 Open Microsoft Paint. 
5.	 Paste the copied image into Paint.
6.	 Shrink the borders to match image size.
7.	 Select Remove background in the upper-left area of the ribbon bar in the Paint within the Image section.
8.	 In the Tools section of the ribbon bar, select Fill.
9.	 Select the white circle in the Colors section, and click the background of the image.
10.	 In the Selection section of the ribbon bar, click the drop-down menu, and click Select all. 
11.	 Right-click the now highlighted modified image, and then click Copy.
12.	 Navigate back to the mexicat_presentation.pptx window.
13.	 On the blank slide you created earlier, right-click, and paste on the right side of the slide.
14.	 Navigate to mexicat_press_release.docx, and read the document.
15.	 Place the windows for PowerPoint and Word Doc side by side.
16.	 Type the following bullet points into the PowerPoint slide that has the edited cat image:

PurrrdyAmazingCompany launched MexiCat, an automatic cat food dispenser. 
It serves Mexican-themed food designed specifically for cats. 
Features include: customizable portions, a programmable schedule, a voice recorder, and 
an anti-tip base. 
The company plans to expand the product line with other international cuisines.

17.	 Select Save as, and enter the following title: updated_mexicat_presentation.pptx
18.	 Simultaneously stop the stopwatch and select Save.
19.	 Record the time.
20.	 Repeat steps 1 through 19 two more times.

Managing client communication and scheduling meetings 

Setup

Initial setup

1.	 Download and extract the workflow folder to the C drive.
2.	 If the folder is already extracted, move it to the C drive.
3.	 Do not modify or rename any files.
4.	 Follow timing instructions when noted.

Installing Adrenalin

1.	 Go to https://www.amd.com/en/support/download/drivers.html.
2.	 Click Download Windows Drivers.
3.	 Open the downloaded executable.
4.	 Click Accept & Express Install.
5.	 Wait for installation to complete.
6.	 Restart the system when prompted.
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Lemonade Server

Installation

1.	 Download Lemonade Server from https://lemonade-server.ai/.
2.	 If the Windows protected your PC popup appears, click More info.
3.	 Click Run anyway.
4.	 Proceed through installation using default options.
5.	 Ensure Run Lemonade Server now is checked.
6.	 Wait 10 to 30 seconds for Lemonade to start.

Changing context size to 16K

1.	 Open the system tray.
2.	 Click the Lemonade icon.
3.	 Set Context Size to 16k.
4.	 Confirm the update notification appears.

Downloading and loading models

1.	 Open the system tray, and click the Lemonade icon.
2.	 Click Open app.
3.	 Search for Qwen3-4B-Instruct-2507-GGUF.
4.	 Click Download.
5.	 Wait for the download to finish.
6.	 Close the download popup.
7.	 Load the model.
8.	 Repeat the steps to download and load Qwen3-Embedding-0.6B-GGUF.
9.	 Ensure both models show as loaded.
10.	 Minimize or close the app.

Node.js

Installation

1.	 Go to https://nodejs.org/en/download.
2.	 Click Windows Installer (.msi).
3.	 Open the installer.
4.	 Proceed through installation without modifying any options.

Verification

1.	 Open a terminal window.
2.	 Enter:

node --version

3.	 Confirm version output appears.
4.	 If an error occurs, restart the system.
5.	 After restarting, start Lemonade Server again.
6.	 Close the terminal.
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Azure

Registering the application

1.	 Sign up or log in at https://azure.microsoft.com/en-us/.
2.	 Search for App registrations.
3.	 Click New Registration.
4.	 Enter an application name.
5.	 Select Accounts in any organizational directory and personal Microsoft accounts.
6.	 Set Redirect URI to: http://localhost:5678/rest/oauth2-credential/callback
7.	 Click Register.

Storing the client ID

1.	 On the app overview page, copy the Client ID.
2.	 Store it in a text file.

Creating the client secret

1.	 Click Certificates & secrets.
2.	 Under Client secrets, click + New client secret.
3.	 Enter a description.
4.	 Click Add.
5.	 Wait for the key to generate.

Storing the client secret

1.	 Copy the Value of the new secret.
2.	 Store it in a text file.
3.	 Ensure both Client ID and Client Secret are available for later steps.

Outlook

Setup

1.	 Open Outlook.
2.	 Log in with the account used for sending and receiving workflow emails.
3.	 Open To Do from the left sidebar.
4.	 Review the interface.

n8n

Installation

1.	 Navigate to the n8n folder inside the extracted AMDTest directory.
2.	 Open the installation file.
3.	 Wait 2 to 3 minutes for package installation.
4.	 Refresh the browser page if needed.

Signup

1.	 Access n8n at http://localhost:5678.
2.	 Sign up using any email address.
3.	 Skip customization by clicking Get Started.

Activation

1.	 Accept the free license key.
2.	 Check email for activation message.
3.	 Click Activate License Key.
4.	 Confirm registration.
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Importing the workflow

1.	 Return to the home page.
2.	 Click Start from scratch.
3.	 Click the … button.
4.	 Select Import from File….
5.	 Navigate to C:\AMDtest\n8n.
6.	 Select n8n-workflow-power_user-2.1.json.

Fixing nodes

Lemonade Chat

1.	 Open the Lemonade Chat Model node.
2.	 Click Create new credentials.
3.	 Click Save.
4.	 Confirm successful connection.
5.	 Close the node.

Microsoft Outlook Trigger

1.	 Open the node.
2.	 Create new credentials.
3.	 Enter the Client ID and Client Secret from Azure.
4.	 Click Connect my account.
5.	 Log in with the Outlook account.
6.	 Accept agreements.
7.	 Close the popup.
8.	 Reopen the node if errors appear.
9.	 Recreate filters manually if needed.
10.	 Close the node.

Creating a task

1.	 Open the node.
2.	 Create new credentials.
3.	 Enter Client ID and Client Secret.
4.	 Click Connect my account.
5.	 Log in with the same Outlook account.
6.	 Reopen the node if errors appear.
7.	 Select Tasks under List Name or ID.
8.	 Close the node.

Creating folders

1.	 Open the node.
2.	 Confirm that there are no errors.
3.	 Close the node.

Getting inbox folder

1.	 Open the node.
2.	 Select the previously created Outlook credential.
3.	 Close the node.

Searching for children folders

1.	 Open the node.
2.	 Confirm no errors.
3.	 Close the node.
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Validation

1.	 Confirm all nodes show no errors.

Saving and publishing workflow
1.	 Click Save in the upper-right corner.
2.	 Confirm notification appears.
3.	 Click Publish.
4.	 Confirm version.
5.	 Close popups.

Setting up RAG
1.	 Click the drop-down menu near Execute workflow.
2.	 Select from Upload your client information here.
3.	 Click Execute workflow.
4.	 Click Choose Files.
5.	 Navigate to C:\AMDtest\n8n.
6.	 Select MexiCat_Project_Content.docx.
7.	 Click Submit.
8.	 Confirm Workflow executed successfully.

Validation

1.	 Confirm the workflow is saved and published.

 AI‑enhanced workflow

Identifying high-priority messages

1.	 Set Timer – Start.
2.	 Log into a separate email account.
3.	 Send an email to the Outlook account.
4.	 Open n8n.
5.	 Click Executions.
6.	 Review execution metrics.
7.	 Open Logs to view node input and output.
8.	 Wait for the workflow to complete.
9.	 Open Outlook.
10.	 Check the High subfolder.
11.	 Open To Do to view the assigned task.

Identifying normal-priority messages

1.	 Send a new email.
2.	 Wait for workflow execution to complete.
3.	 Check Outlook for the response.
4.	 Check To Do for the generated task.

Identifying spam/non‑reply emails

1.	 Send a new email.
2.	 Invalid emails will be moved to the Notification subfolder.

Identifying low-priority messages

1.	 Send a new email.
2.	 Wait for workflow execution to complete.
3.	 Check Outlook for the response.
4.	 Check To Do for the generated task.
5.	 Set Timer – Stop.
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Manual workflow
1.	 Set Timer – Start.
2.	 Read new unread emails.
3.	 Classify each email as high, normal, or low priority.
4.	 Send an acknowledgment email including expected response time: 

• High: within 2 hours

• Normal: within 2 business days

• Low: within 7 business days

5.	 Write a title and description for a task.
6.	 Create a task in the To Do app.
7.	 Attach the email to the task.
8.	 Set Timer – Stop.

Testing productivity while simultaneously running a large language model

Initial setup
1.	 Go to Settings > System > Display > Brightness and adjust it to 35%.

Setting up Lemonade 

1.	 Download and install Lemonade Server from https://lemonade-server.ai/.
2.	 Launch Lemonade Server.
3.	 If you don’t see Lemonade in Taskbar, go to Settings  Personalization  Taskbar Under “other system tray icons”, turn on 

Lemonade (Named - Python), So that, it will appear in Taskbar.
4.	 If this is your first run, right-click the Lemonade icon in your taskbar, and select Model Manager.
5.	 In the BY RECIPE panel, click the llama.cpp category. Scroll down to gpt-oss-20b-mxfp4-GGUF, and download it. 
6.	 In the BY RECIPE panel, click the FastFlowLM NPU category. Scroll down to Llama-3.2-3B-FLM, and download it.

Setting up Procyon 

1.	 Buy, download, and install Procyon from https://benchmarks.ul.com/procyon/office-productivity-benchmark. 
2.	 Open it, log in, and provide a license key.

Setting up workflow prerequisites

1.	 Go to Microsoft Store, download Python 3.13, and install it.
2.	 Open terminal, and run this command to install openai: 

pip install openai

AI NPU-enhanced workflow
1.	 Run Windows PowerShell with administrator access and run this command: 

Set-ExecutionPolicy RemoteSigned

2.	 Launch Teams, and log in with your account.
3.	 Click the Meet tab on the left side, click Create a meeting link, and click Create and copy link. 
4.	 In the Meeting links section, click Join, and make sure the camera is turned on. 
5.	 In the Backgrounds section, click Video effects, and choose any option.
6.	 Turn the microphone off, and click Join now. 
7.	 Minimize Teams.
8.	 Launch Lemonade server.
9.	 Open terminal and run: 

python .\C:\AMDTest\Teams_Meeting\lemonade3.py 

• (In some cases, you’d have to use “py” instead of “python” in the command.)
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10.	 Minimize the terminal.
11.	 In the Teams_Meeting folder of the extracted AMDTest folder, select the Procyon_loops_then_export_PDF.ps1 file, right-click, and select 

Run with PowerShell.
12.	 Enter the path to store the benchmark result to, and click Enter.
13.	 Enter the number of times you want the benchmark to run (i.e. 5), and click Enter.
14.	 Enter the base filename for the result PDF, and click Enter.
15.	 Wait for the benchmark to finish.
16.	 Once the benchmark completes, go to the location you provided for the result files.
17.	 Go back to the terminal, stop the LLM running by pressing CTRL+C, and exit.
18.	 Leave the Teams meeting, and close all applications.
19.	 Repeat steps 1 through 18 two more times.

AI GPU-enhanced workflow
1.	 Run Windows PowerShell with administrator access and run this command: 

Set-ExecutionPolicy RemoteSigned

2.	 Launch Teams, and log in with your account.
3.	 Click the Meet tab on the left side, click Create a meeting link, and click Create and copy link. 
4.	 In the Meeting links section, click Join, and make sure the camera is turned on. 
5.	 In the Backgrounds section, click Video effects, and choose any option.
6.	 Turn the microphone off, and click Join now. 
7.	 Minimize Teams.
8.	 Launch Lemonade server.
9.	 Open terminal and run: 

python .\C:\AMDTest\Teams_Meeting\lemonade2.py 

• (In some cases, you’d have to use “py” instead of “python” in the command.)

10.	 Minimize the terminal.
11.	 In the Teams_Meeting folder of the extracted AMDTest folder, select the Procyon_loops_then_export_PDF.ps1 file, right-click, and select 

Run with PowerShell.
12.	 Enter the path to store the benchmark result to, and click Enter.
13.	 Enter the number of times you want the benchmark to run (i.e. 5), and click Enter.
14.	 Enter the base filename for the result PDF, and click Enter.
15.	 Wait for the benchmark to finish.

16.	 Once the benchmark completes, go to the location you provided for the result files.
17.	 Go back to the terminal, stop the LLM running by pressing CTRL+C, and exit.
18.	 Leave the Teams meeting, and close all applications.
19.	 Repeat steps 1 through 18 two more times.Primary contributors
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the trademarks of their respective owners. For additional 
information, review the science behind this report.

DISCLAIMER OF WARRANTIES; LIMITATION OF LIABILITY:

Principled Technologies, Inc. has made reasonable efforts to ensure the accuracy and validity of its testing, however, Principled Technologies, Inc. specifically disclaims 
any warranty, expressed or implied, relating to the test results and analysis, their accuracy, completeness or quality, including any implied warranty of fitness for any 
particular purpose. All persons or entities relying on the results of any testing do so at their own risk, and agree that Principled Technologies, Inc., its employees and its 
subcontractors shall have no liability whatsoever from any claim of loss or damage on account of any alleged error or defect in any testing procedure or result. 

In no event shall Principled Technologies, Inc. be liable for indirect, special, incidental, or consequential damages in connection with its testing, even if advised of 
the possibility of such damages. In no event shall Principled Technologies, Inc.’s liability, including for direct damages, exceed the amounts paid in connection with 
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